A Principled Technologies report: Hands-on testing. Real-world results.

Enjoy up to 54% better
system responsiveness
on office tasks based on

higher SYSMark 2018
overall scores”

Start adding data into
Microsoft OneNote in
up to 43% less time”

Render 4K Adobe®
Premiere® Pro video in
up to 24% less time®

Realize up to 143% better
processing power to

run Al operations locally
based on AIXPRT ML
inference scores’

*Dell OptiPlex 5080 Micro Desktop with a

10th Gen Intel Core i5-10600T vPro® processor
vs. HP ProDesk 405 G4 Mini PC with an AMD
Ryzen 5 PRO 2400GE processor

Make the most of your time
as well as your space with

Dell OptiPlex small and micro
form-factor desktops powered
by Intel Core processors

vs. comparable HP ProDesk and
EliteDesk desktops powered by
AMD Ryzen PRO processors

You know you want a Window 10 Pro desktop that doesn’t
take up much room, but how does the Intel® Core™

or AMD Ryzen™ processor you choose to power that
desktop affect your experience? We ran performance,
system responsiveness, productivity, and content creation
comparisons on Dell™ OptiPlex™ compact desktops powered
by Intel Core i3, i5, and i7 processors against comparable
HP ProDesk and EliteDesk compact desktops powered by
AMD Ryzen 3, 5, and 7 PRO processors to find out.
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What we tested

In this study, we combined benchmark and
scenario-based testing to compare performance,
system responsiveness, productivity, and
content creation on the following devices.

Performance

On all six desktops, we ran three real-world benchmarks:
SYSmark 2018, WebXPRT 3, and AIXPRT. SYSmark 2018
workloads mimic day-to-day application usage patterns;
WebXPRT 3 compares browser performance; and AIXPRT
measures machine learning inference performance.-**

Space-saving desktops with entry-level CPU specs

* 8 GB of memory
® 256 GB of PCle® SSD storage

Dell OptiPlex 3080 Micro Desktop
powered by a 10th Gen Intel Core i3-
10100T processor with integrated Intel
UHD Graphics 630

VS.

HP ProDesk 405 G4 Desktop Mini PC
with an AMD Ryzen 3 PRO 2200GE
processor with integrated AMD Radeon™
Vega 8 graphics

Space-saving desktops with mid-range CPU specs

* 8 GB of memory
® 256 GB of PCle SSD storage

Dell OptiPlex 5080 Micro Desktop

SYSmark 2018 overall score
Higher is better

Good

Better

Best

WebXPRT 3 overall score
Higher is better

Good

Better

Best

1,832

241

AIXPRT ResNet-50 maximum inference throughput
Images per second | Higher is better

powered by a 10th Gen Intel Core i5- Good
10600T vPro processor with integrated
Intel UHD Graphics 630 Better
vs. Best 64.0
HP ProDesk 405 G4 Desktop Mini PC
with an AMD Ryzen > PRO 2400GE Good Dell OptiPlex 3080 HP ProDesk 405 G4
- _ oo ell OptiPlex roDes
processor W|th.|ntegrated AMD Radeon-RX Micro with a 10% Gen Mini PC with an AMD
Vega 11 graphics Intel Core i3-10100T Ryzen 3 PRO 2200GE
fprocessor fprocessor
Better m Dell OptiPlex 5080 HP ProDesk 405 G4
. . . Micro with a 10" Gen Mini PC with an AMD
Space-saving desktops with high-end CPU specs Intel Core i5-10600T Ryzen 5 PRO 2400GE
16 GB f vPro fprocessor fprocessor
o of memory
* 512 GB of PCle SSD storage Best  m Dell OptiPlex 7080 HP EliteDesk 705 G5

Dell OptiPlex 7080 Small Form
Factor Desktop powered by a 10th
Gen Intel Core i7-10700 processor
with NVIDIA® GeForce® GT 730

SFF with a 10" Gen
Intel Core i7-10700
processor

SFF with an AMD
Ryzen 7 PRO 3700
processor

Figure 1: SYSmark 2018 overall performance qualification scores,
WebXPRT 3 Microsoft Edge browser overall scores, and AIXPRT
ResNet-50 max inference throughput scores. Higher is better.
Vvs. Source: Principled Technologies.

HP EliteDesk 705 G5 SFF with
an AMD Ryzen 7 PRO 3700
processor with dedicated AMD
Radeon 520 Graphics

dedicated graphics
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System responsiveness

Any computer that keeps you waiting too long can be
frustrating, so we hand-timed how long it took for each

desktop to boot up, go to sleep, and return from sleep.

Boot the system
Seconds | Lower is better

Good
Better

Best
0

Put the system to sleep

Seconds | Lower is better

Good 3.0 6.1
2.9
Better 49
2.5
Best 41

0

Wake the system from sleep
Seconds | Lower is better

6.6
Good 7.7
6.4
Better 7.8
6.7
Best 7.5

o

Good W Dell OptiPlex 3080
Micro with a 10 Gen
Intel Core i3-10100T
fprocessor

Better W Dell OptiPlex 5080

Micro with a 10" Gen
Intel Core i5-10600T
vPro processor

Best m Dell OptiPlex 7080
SFF with a 10" Gen
Intel Core i7-10700
processor

12.6
20.0
13.6
17.3
12.3
18.7

20

20

20

HP ProDesk 405 G4
Mini PC with an AMD
Ryzen 3 PRO 2200GE
processor

HP ProDesk 405 G4
Mini PC with an AMD
Ryzen 5 PRO 2400GE
processor

HP EliteDesk 705 G5
SFF with an AMD
Ryzen 7 PRO 3700
processor

Figure 2: Time (in seconds) to boot, sleep, and
return from sleep. Lower (faster) is better.

Source: Principled Technologies.

Productivity

Whether you're using Microsoft 365 tools for work or play,
the faster you can complete items on your to-do list, the
better. We hand-timed how long it took for each desktop
to complete a few simple Microsoft 365 tasks.

Open a 93MB Excel spreadsheet

Seconds | Lower is better

18.4
Good
16.8
Better
15.1
Best 17.6

o

26.6

271

40

Insert a 46MB Excel spreadsheet into OneNote

Seconds | Lower is better

19.
Good S
7.
Better 2
15.3
Best 18.8

o

Open a 180MB PowerPoint deck

Seconds | Lower is better

Good
Better
Best
0
Good Dell OptiPlex 3080
Micro with a 10" Gen
Intel Core i3-10100T
processor
Better m Dell OptiPlex 5080

Micro with a 10" Gen
Intel Core i5-10600T
vPro processor

Best m Dell OptiPlex 7080
SFF with a 10" Gen
Intel Core i7-10700
processor

29.8
28.9
40
B85.5
40.6
33.1
39.4

27.3
27.7

40

HP ProDesk 405 G4
Mini PC with an AMD
Ryzen 3 PRO 2200GE
processor

HP ProDesk 405 G4
Mini PC with an AMD
Ryzen 5 PRO 2400GE
processor

HP EliteDesk 705 G5
SFF with an AMD
Ryzen 7 PRO 3700
processor

Figure 3: Time (in seconds) to perform tasks in
Microsoft 365 applications. Lower (faster) is better.

Source: Principled Technologies.
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Content creation

The faster you complete creative projects, the more time

you have to dedicate to other activities. We hand-timed
how long it took for each desktop to complete a few
simple Adobe Creative Cloud® tasks.

Export a 609MB PDF to Word from Adobe
Acrobat Reader®
Seconds | Lower is better

187.3
Good 231.3
164.7
Better 215.1
Best 119
Create a 45MP photo merge panorama
in Lightroom® Classic
Seconds | Lower is better
62.2
Better 80.2
Best 227921
Render a 687MB 4K video to H.264 in
Adobe Premiere Pro
Seconds | Lower is better
112.7
el 188.4
117.5
Better 156.4
Best 8%67_3
Good  m Dell OptiPlex 3080 HP ProDesk 405 G4
Micro with a 10* Gen Mini PC with an AMD
Intel Core i3-10100T Ryzen 3 PRO 2200GE
processor processor
Better M Dell OptiPlex 5080 HP ProDesk 405 G4
Micro with a 10 Gen Mini PC with an AMD
Intel Core i5-10600T Ryzen 5 PRO 2400GE
vPro processor processor
Best m Dell OptiPlex 7080 HP EliteDesk 705 G5

SFF with a 10" Gen
Intel Core i7-10700
processor

SFF with an AMD
Ryzen 7 PRO 3700
processor

Figure 4: Time (in seconds) to perform tasks in Adobe
Creative Cloud applications. Lower (faster) is better.
Source: Principled Technologies.

Conclusion

In our benchmark and scenario-based comparisons, we
found Dell OptiPlex compact desktops powered by Intel
Core i3, i5, and i7 processors outperformed comparable
HP ProDesk and EliteDesk compact desktops powered by
AMD Ryzen 3, 5, and 7 PRO processors.

1 BAPCo, “SYSmark 2018 white paper,”
accessed October 28, 2020,
https://bapco.com/wp-content/uploads/2018/08/
SYSmark_2018_White_Paper_1.0.pdf.

2 Principled Technologies, “WebXPRT 3,”
accessed October 28, 2020,
https://www.principledtechnologies.
com/benchmarkxprt/webxprt/.

3 Principled Technologies, "AIXPRT”
accessed October 28, 2020,
https://www.principledtechnologies.
com/benchmarkxprt/aixprt/.
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Science

We concluded our hands-on testing on October 13, 2020. During testing, we determined the appropriate hardware
and software configurations and applied updates as they became available. The results in this report reflect
configurations that we finalized on September 4, 2020 or earlier. Unavoidably, these configurations may not represent
the latest versions available when this report appears.

Our results

While the report highlights benchmark overall scores and hand-timed results for individual tasks, the science shows granular results from all

benchmark and scenario-based testing.

Table 1: Results of our benchmark testing. These scores are the median of three runs.

Dell OptiPlex  HP ProDesk Dell OptiPlex  HP ProDesk Dell OptiPlex  HP EliteDesk
3080 Micro 405 G4 5080 Micro 405 G4 7080 Small 705 G5
Desktop with  Desktop Mini  Desktop with  Desktop Mini ' Form Factor  SFF with an
a 10th Gen PC with an a 10th Gen PC with an Desktop with  AMD Ryzen
Intel Core AMD Ryzen 3 Intel Core i5- AMD Ryzen 5 a 10th Gen 7 PRO 3700
i3-10100T PRO 2200GE  10600T vPro  PRO 2400GE  Intel Core processor
processor processor processor processor i7-10700
processor
Sysmark 2018
Overall rating (Higher is better) 1,234 926 1,418 920 1,832 1,513
AIXPRT
ResNet-50 maximum inference
throughput, images/sec 333 18.0 39.9 16.4 64.0 50.9
(Higher is better)
ResNet-50 minimum inference latency
per image (90th percentile), ms 48.4 78.1 46.9 93.8 31.2 48.4
(Lower is better)
SSD-MobileNet-v1 maximum inference
throughput, images/sec 21.0 11.0 27.2 12.6 40.3 32.6
(Higher is better)
SSD-MobileNet-v1 minimum inference
latency per image (90th percentile), ms 62.5 109.4 46.9 93.8 31.2 46.9
(Lower is better)
WebXPRT 3 (Microsoft Edge browser)
Overall rating (Higher is better) 183 156 196 158 241 222
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Table 2: Results (in seconds) of our hand-timed testing. These scores are the median of three runs. Lower is better.

Entryovel Midrange ghend

Dell OptiPlex HP ProDesk Dell OptiPlex HP ProDesk Dell OptiPlex HP EliteDesk

3080 Micro 405 G4 5080 Micro 405 G4 7080 Small 705 G5
Desktop with  Desktop Mini  Desktop with ~ Desktop Mini  Form Factor SFF with an
a 10th Gen PC with an a 10th Gen PC with an Desktop with a  AMD Ryzen
Intel Core AMD Ryzen 3 Intel Core AMD Ryzen 5  10th Gen Intel 7 PRO 3700
i3-10100T PRO 2200GE  i5-10600T vPro PRO 2400GE  Core i7-10700  processor
processor processor processor processor processor
System responsiveness
Boot 12.6 20.0 13.6 19.3 12.3 18.7
Sleep 3.0 6.1 2.9 4.9 2.5 4.1
Resume from sleep 6.6 7.7 6.4 7.8 6.7 7.5
Productivity
Microsoft Word
Open a Word document 3.5 5.1 3.7 6.1 2.7 4.0
Perform a word replacement 1.5 1.9 1.5 1.8 1.3 1.5
Microsoft Excel
Open an Excel spreadsheet 18.4 26.6 16.8 271 151 17.6
Eaelijlr;i:n”“mbe““””Ch 24 33 24 34 22 3.0
Microsoft PowerPoint
Open a PowerPoint slide deck 355 40.6 33.1 394 27.3 27.7
Export to PDF 9.0 10.8 8.5 10.4 7.3 8.1
Microsoft OneNote
Open OneNote 1.7 2.2 1.3 2.3 1.2 1.5
Insert a spreadsheet 19.3 29.8 17.5 28.9 15.3 18.8
Content creation
Adobe Acrobat
ggﬁn an Adobe Acrobat Reader 10 15 09 14 08 09
Export to Word 187.3 231.3 164.7 2151 135.8 141.9
Adobe Lightroom
Open Adobe Lightroom Classic 13.8 23.4 12.5 23.0 1.2 14.2
Create a Photo Merge panorama 68.2 79.3 62.2 80.2 27.2 29.1
Adobe Premiere Pro
Open Adobe Premiere Pro 10.7 18.7 12.3 19.7 10.5 121
E‘fz"gfr a RED 4K video file to 112.7 188.4 117.5 156.4 80.7 86.3
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System configuration information

Table 3: Detailed information on the “Space-saving desktops with entry-level CPU specs” we tested.

System configuration information Dell OptiPlex 3080 Micro Desktop

HP ProDesk 405 G4 Mini PC

Processor

Vendor Intel AMD

Name Core i3 Ryzen 3 PRO
Model number 10100T 2200GE

Core frequency (GHz) 3.0-3.8 3.2-3.6
Number of cores 4 4

Cache (MB) 6 4

Memory

Amount (GB) 8 8

Number of DIMMs 2 x 4GB 2 x 4GB

Type DDR4 DDR4

Speed (MHz) 2,933 2,666
Graphics

Vendor Intel AMD

Model number UHD Graphics 630 Radeon Vega 8
Storage

Amount (GB) 256 256

Type M.2 PCle NVMe M.2 PCle NVMe

Connectivity/expansion

Wired internet

Realtek PCle Gbe

Realtek PCle Gbe

Wireless internet

Qualcomm QCA61x4A

Intel Wireless-AC 9260

Bluetooth 5.0 5.0
usB Front Front
2 x USB-A ports (version 3.2 Gen 1) 1 x USB-A port (version 3.1 Gen 1 (charging))
1 x USB-A port (version 3.1 Gen 1)
Rear
2 x USB 2.0 ports (1 with Smart Power on) Rear
2 x USB-A ports (version 3.2 Gen 1) 4 x USB-A ports (version 3.2 Gen 1)
. 1 x DisplayPort 1.4 1 x DisplayPort 1.2
Video 1 x HDMI 1 x HDMI
Operating system
Vendor Microsoft Microsoft
Name Windows 10 Pro Windows 10 Pro

Build number or version

10.0.19041

10.0.19041

Make the most of your time as well as your space with Dell OptiPlex small and micro form-factor desktops powered by Intel Core processors

November 2020 | 3



System configuration information Dell OptiPlex 3080 Micro Desktop

HP ProDesk 405 G4 Mini PC

BIOS

BIOS name and version

Dell 1.2.0

HP R24 Ver.02.13.00

Dimensions

Height (in) 1.4 1.33
Width (in) 7.0 6.88
Depth (in) 7.2 6.96

Table 4: Detailed information on the “Space-saving desktops with mid-range CPU specs” we tested.

System configuration information Dell OptiPlex 5080 Micro Desktop

HP ProDesk 405 G4 Mini PC

Processor

Vendor Intel AMD

Name Core i5 Ryzen 5 PRO
Model number 10600T 2400GE

Core frequency (GHz) 2.4-4.0 3.2-3.8

Number of cores 6 4

Cache (MB) 12 4

Memory

Amount (GB) 8 8

Number of DIMMs 2 x4GB 2 x 4GB

Type DDR4 DDR4

Speed (MHz) 2,933 2,666

Graphics

Vendor Intel AMD

Model number UHD Graphics 630 Radeon RX Vega 11
Storage

Amount (GB) 256 256GB

Type M.2 PCle NVMe M.2 PCle NVMe
Connectivity/expansion

Wired internet Intel 1219-LM Realtek PCle Gbe

Wireless internet

Intel Wi-Fi 6 AX201

Intel Wireless-AC 9260

Bluetooth

5.1

5.0
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System configuration information

Dell OptiPlex 5080 Micro Desktop

HP ProDesk 405 G4 Mini PC

USB Front Front
1 x USB-C port (version 3.2 Gen 2) 1 x USB-A port (version 3.1 Gen 1 (charging))
1 x USB-A port (version 3.2 Gen 1 (charging)) 1 x USB-A port (version 3.1 Gen 1)
Rear Rear
4 x USB-A ports (version 3.2 Gen1) 4 USB-A ports (version 3.2 Gen 1)
Video 2 x DisplayPort 1.4 3 x DisplayPort 1.2

Operating system

Vendor

Microsoft

Microsoft

Name

Windows 10 Pro

Windows 10 Pro

Build number or version

10.0.19041

10.0.19041

BIOS

BIOS name and version

Dell 1.1.7

HP R24 Ver.02.13.00

Dimensions

Height (in)

1.42

1.33

Widsth (in)

7.03

6.88

Depth (in)

6.96

Table 5: Detailed information on the “Space-saving desktops with high-end CPU specs” we tested.

System configuration information

Dell OptiPlex 7080 SFF Desktop

HP EliteDesk 705 G5 SFF PC

Processor

Vendor Intel AMD
Name Core i7 Ryzen 7 PRO
Model number 10700 3700
Core frequency (GHz) 2.9-4.8 3.6-4.4
Number of cores 8 8
Cache (MB) 16 32
Memory

Amount (GB) 16 16
Number of DIMMs 2 x 8GB 2x 8GB
Type DDR4 DDR4
Speed (MHz) 2,933 2,666
Graphics

Vendor NVIDIA AMD

Model number

NVIDIA GeForce GT 730

Radeon R7 430

Video RAM

2GB GDDR5

2GB GDDRS5
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System configuration information

Dell OptiPlex 7080 SFF Desktop

HP EliteDesk 705 G5 SFF PC

Storage

Amount (GB) 512 512

Type M.2 PCle NVMe M.2 PCle NVMe
Connectivity/expansion

Wired internet Intel 1219-LM Realtek PCle Gbe

Wireless internet

Intel Wi-Fi 6 AX201

Intel Wi-Fi 6 AX200

Bluetooth 5.1 5.0
USB Front Front
2 x USB 2.0 Ports (1 with PowerShare) 1 x USB-C port (version 3.1 Gen 2)
1 x USB-A port (version 3.2 Gen 2) 4 x USB-A ports (version 3.1 Gen 1 (1 x
1 x USB-C port (version 3.2 Gen 2) fast charging))
Rear Rear
1 x USB-A port (version 3.2 Gen 2) 2 x USB 2.0 Type-A
3 x USB=A ports (version 3.2 Gen 1) 4 x USB 3.1 Gen 1 Type-A
2 x USB 2.0 ports with Power On
Video 4 x DisplayPort 1.4 4 x DisplayPort 1.2

Operating system

Vendor

Microsoft

Microsoft

Name

Windows 10 Pro

Windows 10 Pro

Build number or version

10.0.19041

10.0.19041

BIOS

BIOS name and version

Dell 1.1.5

HP RO9 Ver.02.06.00

Dimensions

Height (in)

3.6

3.7

Width (in)

10.6

Depth (in)

11.53
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How we tested

Setting up the desktops

Creating and updating the OEM Windows 10 Pro Image

1.

ok wn

Boot the system.

To complete installation, follow the on-screen instructions using the default selections when appropriate.
Run Windows Update, and install all updates available.

Launch the Windows Store app, and install all Store app updates.

Launch each vendor-proprietary utility app installed on each system, and update any drivers or BIOS files. For Dell, run the Dell
Command Update utility. For HP, run the HP Support Assistant utility.

To install the latest chipset and graphics drivers available, depending on the hardware of each system go to either https://www.intel.
com/content/www/us/en/support.html, https://www.amd.com/en/support or https://www.nvidia.com/en-us/geforce/drivers/.

Verify the date and time are correct, and synchronize the system clock with the time server.
Disable Automatic Windows Update:

Right-click the Windows Start button.

Select Computer Management.

Select Services and Applications.

Select Services.

Scroll down, and double-click Windows Update.

Click Stop.

From the Startup drop down menu, select Disabled.

@ "o o0 T

Capturing an image

1.
2.

ok~ w

Connect an external HDD to the system.

Right-click the desktop, and select Personalize>Home->Update & security->Backup->More options=>See advanced settings—> System
Image Backup->Create a system image.

Verify that the external HDD is selected as the save drive, and click Next.

Verify that all drives are selected to back up, and click Next.

Click Start backup.

At Do you want to create a system repair disc, select No, and close the dialogs.

Restoring an image

0 0o Nok WD~

Connect an external HDD to the system.

Press and hold the Shift key while restarting the system.
Select Troubleshoot.

Select Advanced options.

Select System image recovery.

Select the User account.

Enter the system password, and click Continue.

Verify that the external HDD is selected, and click Next.
Once the recovery has completed, click Finish.
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Measuring performance with benchmarks

SYSmark 2018
Avoiding antivirus software conflicts

SYSmark 2018 is not compatible with any virus-scanning software, so we uninstalled any such software present on the desktop PCs before we
installed the benchmark.

Avoiding pre-installed software conflicts

* SYSmark 2018 installs the following applications, which its test scripts employ:

Productivity

* Adobe Acrobat Pro DC

e AutolT 3.3.14.2

* BowPad64-2.3.3 installer

* Google® Chrome®

* Microsoft Excel 2016

* Microsoft OneNote 2016

* Microsoft Outlook 2016

* Microsoft PowerPoint 2016
* Microsoft Word 2016

* Windows Zip

Creativity

* Adobe Photoshop CC 2017
* Adobe Lightroom Classic CC
* CyberLink PowerDirector® 2015

* Responsiveness

e Adobe Acrobat Pro DC

* Adobe Lightroom Classic CC
* Adobe Photoshop CC 2017
e CyberLink PowerDirector 2015
* Google Chrome

* Microsoft Excel 2016

* Microsoft OneNote 2016

* Microsoft Outlook 2016

* Microsoft PowerPoint 2016

* Microsoft Word 2016

If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts.
To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs
SYSmark 2018 uses—before we installed the benchmark.
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Using the SYSmark built-in configuration tool

This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

The Configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required

e Disables User Account Control (UAC)
e Set DPI Scaling to 100%

e Disables Low Battery Actions

e Disables Network Proxies

* Disables System Sleep and Hibernate
* Disables Windows Update

Level 2 - Recommended

e Disables User Account Control (UAC)

e Set DPI Scaling to 100%

* Disables Low Battery Actions

e Disables Network Proxies

* Disables System Sleep and Hibernate

* Disables Windows Update

* Create BAPCo power scheme

* Set Power Plan Type to High Performance
e Set CPU High Performance

¢ Disables Disk Defrag

* Disables Windows Error Reporting

e Disables Windows Lock Screen

* Disables Windows Pop-ups

e Disables Screen Saver and Monitor Timeout
e Disables Windows Sidebar/Gadgets

* Disables Desktop Slideshow

e Disables Windows Defender

e Disables Windows Firewall

e Set Font Smoothing

Level 3 - Optional

* Disables Hard Disk Timeout
e Disables System Restore

* Ignores Laptop Lid Close

We chose the official BAPCo ‘Run Benchmark’ default as outlined in the BAPCo SYSmark2018 User Guide http://bapco.com/wp-content/
uploads/2018/10/BAPCo_SYSmark2018_user_guide.pdf, which runs the benchmark using the Required and Recommended options.

Setting up the test
1. Install SYSmark 2018 with the default options.
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Running the test

1. Launch SYSmark 2018.

2. Click the Settings gear icon.

3. Foriterations, enter 3.

4. Verify that Conditioning Run is enabled.

5. Enable Process Idle Tasks.

6.  Enter a name for the benchmark run.

7. To return to the main menu, click the Back button to return to the main menu.
8.  Click Run Benchmark.

9. When the benchmark finishes, record the SYSmark 2018 benchmark results.
WebXPRT 3

Setting up the test

1.

Verify that the newest version of Microsoft Edge is installed. If it is not, go to https://www.microsoft.com/en-us/edge to download
and install it.

Running the test

1.

Hwn

® N o

9.

10.
11.
12.
13.

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks Do notinteract with the system until the
command completes.

After the command completes, wait five minutes before running the test.

Open the web browser under test and go to http://www.principledtechnologies.com/benchmarkxprt/webxprt/.
Click Run WebXPRT 3.

At the Ready to test your browser screen, click Continue.

Click Start.

When the test completes, record the results.

Click the option to rerun WebXPRT 3.

When the test completes, record the results.

Repeat steps 11 through 12 once more.

AIXPRT
Setting up the test

= = 0 0 NON U B~ WN =

SN
wn

Go to https://www.principledtechnologies.com/benchmarkxprt/aixprt/ and click the Start here link.

For Operating System, choose Windows 10.

For Host hardware, choose Desktop.

For Toolkit, choose TensorFlow.

For Target hardware, choose CPUs.

For Workload, choose ResNet-50 and SSD MobileNet v1.

To download the AIXPRT_1.0_Tensorflow_Windows.zip installation package, click Download.

Unzip the AIXPRT_1.0_Tensorflow_Windows.zip file to C:\.

Download the Python v3.6.8 Windows x86-64 executable installer from https://www.python.org/downloads/windows/.
Click the Python executable file. Check the box next to Add Python 3.6 to path, and click Install Python.

Navigate to the python3 install directory (default location is C:\Users\<name>\AppData\Local\Programs\Python\Python36é) and
duplicate python.exe file. Rename the duplicate file to python3.exe.

Open a administrative command prompt.

To install the necessary dependencies, type the following:

pip3 install pyreadline

pip3 install Pillow

pip3 install opencv-python

pip3 install --upgrade wmi

pip3 install --upgrade pypiwin32

pip3 install --upgrade setuptools==41.0.0
pip3 install tensorflow==1.14
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Running the test

1.

Hwn
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Boot the system.

Select Windows Start.

Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
* Do not interact with the system until the command completes.

After the command completes, wait five minutes before running the test.

Type cd C:\AIXPRT\Harness.

Type python3 index.py.

When the test is complete, the benchmark saves the results to AIXPRT/Results in JSON format, and also generates CSV files with the

name {ConfigName}_RESULTS_SUMMARY.csv.
By default, the AIXPRT config file is set to run 3 iterations. Record the results.

Testing hand-timed tasks

System responsiveness
Running the “Time to boot” test

ok wh =

N

10.

Prepare the stopwatch.

Simultaneously start the timer, and press the power button.

When taskbar loads, stop the stopwatch, and record the results.

Select Windows Start.

Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks

* Do not interact with the system until the command completes.

After the command completes, wait five minutes before running the test.
Simultaneously start the timer and shut down the system.
When the power button light has turned off, stop the timer, and record the resuilts.

Repeat steps 1 through 9 twice more.

Setting up the “Time to sleep and time to resume from sleep” tests

S e o

Disable Require a password when a computer wakes.

To bring up the Run command prompt, press Windows Key + R.

To open the Local Group Policy Editor, type gpedit.msc.

Browse to Computer Configuration->Administrative Templates=>System->Power Management->Sleep Settings.
Double-click Require a password when a computer wakes (plugged in), and select Disable. Click Apply.

Close the Local Group Policy Editor and shut down the system.

Running the “Time to sleep and time to resume from sleep” tests

1.

Hwn
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Boot the system.

Select Windows Start.

Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
* Do not interact with the system until the command completes.

After the command completes, wait five minutes before running the test.

Simultaneously start the timer and put the system in Sleep.

When the power button light has turned off, stop the timer, and record the results.

Wiait 30 seconds.

To wake the system out of Sleep, simultaneously start the timer and press the power button.
When the taskbar has loaded, stop the timer, and record the results.

Repeat steps 1 through 10 twice more.
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Productivity

Running the “Opening a 90MB Microsoft Word document and performing a word replacement” test
1.  Boot the system.

2. Select Windows Start.

3. Type cmd, and press Ctrl+Shift+Enter.

4. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks

* Do not interact with the system until the command completes.

o

After the command completes, wait five minutes before running the test.
6. Simultaneously start the timer and launch Word by clicking on the test Word document.

7. When the Word document has fully loaded, as indicated by the words Page 1 of 38 10473 words appearing, stop the timer, and
record the results.

8.  To bring up the Find/Replace dialog box, press CTRL + H.
9. In the Find What field type I.

10. In the Replace With field type TEST.

11. Simultaneously start the timer and select Replace All.

12. When every | has been replaced, stop the timer.

13. Close the Word document. Do not save changes.

14. Shut down the system.

15. Repeat steps 1 through 14 twice more.

Setting up the “Opening a 93MB Microsoft Excel spreadsheet and performing a number crunch calculation” test
1. Launch Microsoft Excel.

2. Click File>Options>Trust Center>Trust Center Settings>Macro Settings. Select Enable all macros and click OK.

3. Close Microsoft Excel.

4. Shut down the system.

Running the “Opening a 93MB Microsoft Excel spreadsheet and performing a number crunch calculation” test
1.  Boot the system.

2. Select Windows Start.

3. Type cmd, and press Ctrl+Shift+Enter.

4. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
* Do not interact with the system until the command completes.

5. After the command completes, wait five minutes before running the test.

6. Simultaneously start the timer and launch Excel by clicking on the test Excel spreadsheet.

7. When the Excel spreadsheet has fully loaded, stop the timer, and record the results.

8.  Press CTRL + R to start the calculation.

9. Record the output.

10. Close the Excel spreadsheet.

11. Shut down the system.

12. Repeat steps 1 through 11 twice more.

Running the "Opening a 180MB Microsoft PowerPoint slide deck and exporting to PDF” test
1. Boot the system.

2. Select Windows Start.

3. Type cmd, and press Ctrl+Shift+Enter.

4. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks

* Do not interact with the system until the command completes.

o

After the command completes, wait five minutes before running the test.
6. Simultaneously start the timer and launch PowerPoint by clicking on the test PowerPoint slide deck.

7. When the PowerPoint slide deck has loaded, as indicated by all 33 slides appearing in the side bar, stop the timer, and
record the results.

8.  Click File>Export->Create PDF/XPS.

9. Simultaneously start the timer and click Publish.

10.  When the PDF has been created, stop the timer, and record the results.
11. Shut down the system.

12. Repeat steps 1 through 11 twice more.
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Running the “Launching Microsoft OneNote and inserting a 46MB spreadsheet” test
1. Boot the system.

2. Select Windows Start.

3. Type cmd, and press Ctrl+Shift+Enter.

4. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
* Do not interact with the system until the command completes.

5. After the command completes, wait five minutes before running the test.

6.  Simultaneously start the timer and launch OneNote.

7. When OneNote has loaded, stop the timer, and record the results.

8. Click Add Page.

9. Click Insert->Spreadsheet>Existing Excel Spreadsheet.

10. Browse to the test Excel spreadsheet file, and click Insert.

11. Start the timer and click Insert spreadsheet.

12. When the Excel spreadsheet has been inserted, stop the timer, and record the results.
13. Shut down the system.

14. Repeat steps 1 through 13 twice more.

Content creation
Running the "Opening a 609MB Adobe Acrobat DC document and exporting to Microsoft Word” test
1. Boot the system.

2. Select Windows Start.

3. Type cmd, and press Ctrl+Shift+Enter.

4. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
* Do not interact with the system until the command completes.

5. After the command completes, wait five minutes before running the test.

6. Simultaneously start the timer and launch Acrobat DC by clicking on the test PDF document.

7. When the PDF document has fully loaded, stop the timer, and record the results.

8. In the right-hand column, expand the Export PDF option.

9. Verify that Microsoft Word is selected, and click Export.

10. Select the Save As directory.

11. Simultaneously start the timer and click Save.

12. When the PDF document has been converted to a Word document, stop the timer, and record the results.
13. Close the documents. Do not save changes.

14. Shut down the system.

15. Repeat steps 1 through 14 twice more.

Running the “Launching Adobe Lightroom Classic and creating a photo merge panorama” test

We used six 45-megapixel .NEF raw images. Each image was 95MB.

1. Boot the system.

2. Select Windows Start.

3. Type cmd, and press Ctrl+Shift+Enter.

4. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
* Do not interact with the system until the command completes.

5. After the command completes, wait five minutes before running the test.

6.  Simultaneously start the timer and launch Lightroom.

7. When Lightroom has fully loaded, Stop the timer, and record the results.

8.  Click the Import button.

9. Select the test file directory and click Import.

10. Press Ctrl + A to select all the imported photos.

11. Click Photo>Photo Merge->Panorama.

12. Simultaneously start the stopwatch and click Merge.

13. When the progress bar in the top left corner disappears, Stop the stopwatch, and record the result.
14. Shut down the system.

15. Repeat steps 1 through 14 twice more.
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Running the “Launching Adobe Premiere Pro and rendering a 687MB RED camera 4K .R3D video file” test
1. Boot the system.

2. Select Windows Start.

3. Type cmd, and press Ctrl+Shift+Enter.

4. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
* Do not interact with the system until the command completes.

5. After the command completes, wait five minutes before running the test.

6.  Simultaneously start the timer and launch Premiere.

7. When Premiere has fully loaded, stop the timer, and record the results.

8.  Select New Project and give the project a name.

9. Press Ctrl + | to Import the test file.

10. Drag the imported file to the bottom timeline.

11. Select Effects>Lumetri Pesets>Filmstocks.

12. Select Fuji F125 Kodak 2393 (by Adobe) and drag it onto the video timeline.
13. To bring up the Export Media dialog, press Ctrl + M.

14.  From the Format dropdown menu, choose H.264.

15. Simultaneously start the stopwatch and click Export.

16. When the progress bar disappears, stop the stopwatch, and record the result.
17. Shut down the system.

18. Repeat steps 1 through 17 twice more.

This project was commissioned by Dell Technologies.

‘ Principled

Technologies®

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:

Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims
any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any
particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its
subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or resullt.

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of
the possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with
Principled Technologies, Inc.’s testing. Customer's sole and exclusive remedies are as set forth herein.
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